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GETTING STARTED WITH CONCEPTDRAW PROJECT

Thank you for your interest in ConceptDraw® PROJECT v8! To begin with, let’s install
the program on your system. To install the product, and activate your trial license:

1. Navigate your web browser to www.ConceptDraw.com and click Sign In.

2. Fill in the form with your information, and then click Submit.

3. Check your email for the message from support@ConceptDraw.com that contains
your confirmation link. (Spam filters may catch this message. If you don’t see
the email within a few minutes, check your “Junk” or “Spam” folders.)

4. Follow the link to confirm your account, and then click "Download”.

5. Once the download is complete, run the installation file.

6. Follow all the on-screen instructions to complete the installation.

7. Once the installation is completed, ConceptDraw STORE runs automatically. The
trial licenses listed in your account will be delivered to your computer automatically

through your internet connection.

8. Congratulations! Your FREE 21-day trial of ConceptDraw PROJECT has begun.
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CREATING PROJECTS

The default view for a new project is the Gantt Chart.

The left pane of this chart displays a list of Tasks. The right pane displays a calendar
and timeline of those tasks.

Figure 1: Gantt Chart

To begin managing a new project, you will need to define the individual Tasks that must

be completed to deliver it. Click the Add button ®  on the Home toolbar to create
a new Task.

Then name the Task, and assign its duration. You can do so by double-clicking on the
fields in the left pane of the Gantt chart, and then typing on your keyboard.

You can also select a Task on the Gantt chart, and then edit its details in the Task
Inspector. Press Cmd+2 on your keyboard to toggle visibility of this Inspector.

Tasks are usually grouped into larger Phases. Use the Indent button "= on the Home
toolbar to subordinate a Task, thereby making the dominant item into a Phase.

You cannot edit a Phase’s duration. The duration of a Phase is determined by the duration
of all the Tasks within it.

Often, one Task must be completed before another can begin. To establish a relationship
between Tasks, select two or more Tasks on the Gantt chart, and then click

the Link button == ~on the toolbar. Editing the duration of linked Tasks will automatically
adjust their position on the Gantt chart.
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ASSIGNING RESOURCES

Once you have outlined the Tasks that comprise your project, the next step is to assign
Resources to those Tasks.

Once you have outlined the Tasks that comprise your project, the next step
is to assign Resources to those Tasks.

Press Cdm+3 on your keyboard to toggle the Resource Assignment Inspector.
Click the check box next to a Resource to assign it to the selected Task.

Figure 2: Assign Resources panel

There are five kinds of Resources: Work,; Material; Cost; Equipment and Company.

Work resources are those with a cost over time. Other resource types have a fixed cost
per unit.

Figure 3: List of Resource Types
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You can quickly add Resources to your project by clicking the buttons in the Assign
Resources tab. For more detailed information on your project’s Resources, click the
Resources button on the main toolbar to view the Resource Sheet.

Figure 4: Resource Sheet

Once you have detailed and assigned your Resources, the Resource Usage View will tell
you at a glance if your Work Resources (i.e., employees) are over taxed.

This dashboard displays the amount of work assigned each day to each Work Resource.
Overworked Resources appear as red bars on the timeline.

Click the + next to each Resource to view the Tasks it is assigned to.

Figure 5: Resource Usage View
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SETTING THE CALENDAR

By default, ConceptDraw PROJECT assumes working hours are between 8am and 5pm,
Monday through Friday. However, creating exceptions to this policy is easy.

Click Calendar button “_ on the toolbar. This will open the Document Properties
window.

From the Calendar tab of this window, you can designate non-default working hours
for specific days, as well as non-working days.

You can also select a specific Work Resource from the drop down menu above

the calendar to change working hours and days for that resource only.

Figure 6: Calendar
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ADDING DETAILS

HYPERLINK

To make referencing information
outside the project file effortless,

you can add text Notes and Hyperlinks
to a Task, Phase, Resource or Project.

Select the item in question,
and then select the Hyperlinks
inspector by pressing Cmd+S5.

The buttons at the bottom

of the Hyperlinks pane allow

you to quickly link to a website,
a file or folder on your computer,
an email address, or other object
within your project file.

Figure 7: Hypernote Inspector

MILESTONE

You can set a Milestone in your Gantt chart by selecting a Task, and then clicking the
“Milestone” checkbox in the Task pane. Milestones do not have duration, but they can be
marked Completed by clicking the “"Complete” checkbox.

Figure 8: Milestone
8
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MANAGING MULTIPLE PROJECTS

ConceptDraw PROJECT allows you to manage multiple Projects in a single file.

You can also add Notes to a Task, Phase, Resource or Project by selecting the item, and
then typing in the Notes inspector (Cmd+6 to toggle visibility).

Select the Multiproject Dashboard view on the toolbar. Multiproject Dashboard view is
similar to the Gantt chart, but the timeline is on a larger scale.
Most of the controls on the toolbar work similarly to the Gantt chart,

such as Add === (to create new Projects) and Link ©= - (to create relationships between
Projects).

However, you cannot edit the duration of a Project. You must return to the Gantt chart
and edit the timeline of the individual Project.

Figure 9: Multiproject Dashboard View
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PROJECT REPORTS

ConceptDraw PROJECT offers a variety of ways to report the status of your project.

L
il
These can be viewed by clicking the Reports button =~ on the toolbar.
You can then select from an array of choices for reporting on your project
in spreadsheet (MS Excel®) format.

Figure 10: Selecting Project Report in Spreadsheet (MS Excel®) Format.
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PRESENTING YOUR PROJECT

You can capture slides of specific views within your project.

To capture slides of your project, scroll to an area of the Gantt Chart or Resources Sheet,
and use the Zoom controls in the View menu to focus on the area you wish

to capture, then click the File menu, select the Create Presentation submenu, and then
click Capture slide.

Thumbnail images of your slides will appear in a tray below the main window.

When you have all the slides you want, select the Create Presentation submenu again.
You can save your slides as Portable Network Graphics files by selecting

Save All Slides as PNG.

Figure 11: Project Slide Preview
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INTEGRATING WITH OTHER CONCEPTDRAW OFFICE APPLICATIONS

Using all three programs in the ConceptDraw Office suite in this way unlocks their true
potential for increasing your productivity and facilitating your workflow.

CONCEPTDRAW PRO

If you have ConceptDraw PRO installed, the item Dashboards in the list of available
reports in the Reports section can be used to generate drawings for tracking the status of
your project at a glance.

Also, the Project Diagrams item can be used to draw a variety of diagrams,

such as PERT charts and WBS (Work Breakdown Structure), suitable for printing
and display.

Figure 12: Project Dashboard
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CONCEPTDRAW MINDMAP

If you also have ConceptDraw MINDMAP installed, you can instantly create a mind map
from your Gantt chart by clicking the Open in MINDMAP item in the menu File. This
allows you to take full advantage of ConceptDraw MINDMAP’s visual, non-linear
organization capabilities for reorganizing your project, and add content via Brainstorming
mode.

Mind map will consist from topics of Project Management type, which contain all project
information. Project Notes will be opened as Notes to topics, The first hyperlink from
multi hyperlink’s list will be also preserved.

You can then send the mind map back to PROJECT to use its more detailed resource and
task management capabilities.

Figure 13: Project Mind Map
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WORKING WITH OTHER APPLICATIONS

ConceptDraw PROJECT has the ability to export to a number of usable file formats, giving
ConceptDraw users powerful flexibility in working with others. Expand the File tab to view
all of ConceptDraw PROJECT's import and export options.

Exporting to MS Project® is one of the best ways to share your project. ConceptDraw
PROJECT 8 is thoroughly compatible with MS Project’s, and can import from native .mpp
format and export to MS Project XML files to make working across operating plat-

forms not only possible, but effortless. ConceptDraw PROJECT 8 is also import/export
compatiblewith Mindjet® MindManager® files.

SOLUTION PARK

ConceptDraw Solution Park is an ever-growing collection of business-specific solutions
and product add-ons that are available to add continued value after the initial purchase
of a ConceptDraw product. For more information, visit
http://www.conceptdraw.com/solution-park

VIDEO ROOM

CS Odessa offers a series of instructional videos for ConceptDraw Products. Users of all
proficiency levels will find here new insights into the product’s functionality, as well as
helpful tips to expedite their workflow.

http://www.conceptdraw.com/video/

SAMPLES

CS Odessa offers an online collection of professional samples designed to help Concept-
Draw users achieve their best. ConceptDraw Samples shows many of the varieties of
tasks and possibilities that the ConceptDraw Product Line can achieve.
http://www.conceptdraw.com/samples/about-samples

NO-CHARGE SUPPORT

CS Odessa offers no-charge support for all licensed and trial users of ConceptDraw Prod-
ucts. ConceptDraw Maintenance Assurance P3 is also available to stay current
with major updates to ConceptDraw Products.
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CROSS-PLATFORM LICENSING

CS Odessa is one of the only companies in the world that offers a cross-platform license.
This means that if you want to install your product on a Mac and a PC for your use,

you can do so with our license. Most companies require that you purchase a separate
license for each platform.

MULTI-DISPLAY SUPPORT

ConceptDraw PROJECT v8 supports working across multiple computer screens.
You can open separate mind maps on different screens and copy-and-paste
from one to the other.

macOS SUPPORT

All ConceptDraw applications are compatible with OS X 10.10 and later.

ABOUT CS ODESSA

Founded in 1993, Computer Systems Odessa supplies cross-platform productivity tools
and graphics technologies to professional and corporate users around the world.

From their headquarters in Odessa, Ukraine, and U.S. office in San Jose, CA, CS Odessa
sells internationally in over 30 countries, both directly and through resellers.

The ConceptDraw Productivity Line has won numerous awards, and is used by hundreds
of thousands all over the world. For more information, visit
www.conceptdraw.com
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FREQUENTLY ASKED QUESTIONS

What is the difference between Technical Support and Maintenance Assurance P3?

Technical support is a no charge item provided to our customers and individuals

trialing or products. Our Tech Support team is there to help you with installing, product
activation, and product issues. Technical support is available by submitting a ticket via
our web site, and by phone and email. Minor product upgrades are at no additional cost.

When purchased at the same time of you ConceptDraw Product purchase, Maintenance
Assurance P3 provides you the next major release of your product at no additional cost.
When the next major upgrade of the product becomes available you will be notified

of its availability for download and installation.

Why is ConceptDraw STORE part of the product I purchased?

When you activate a purchased license for your product, that authorization is stored

in the cloud, and then synchronized with your desktop product(s) using ConceptDraw
STORE. We do this so if the unthinkable occurs and you have a catastrophic event with
your computer such as a hard disk failure, you can log into your account

on ConceptDraw.com and retrieve your license, saving you time and headaches.

The ConceptDraw STORE also manages the versioning of all of your products, and give

you access to all of the additional business solutions found in the ConceptDraw Solution
Park.

I am with a large organization; do you support other methods of installation besides
the one I experienced from my trial?

We have additional methods of delivering product to the users in your organization.
Please contact our sales or support team for details.

Do you have pricing for academia and non-profits?

Yes, we have aggressive pricing for students, educators and employees of certified
nonprofit organizations. Contact our sales team for pricing details.
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KEYBOARD SHORTCUTS

Following is an abbreviated list of the most commonly used keyboard shortcuts.

See the in-program Help file for the comprehensive list.

Keystroke Operation

Cmd + N Create a New Document

Cmd + O Open a Document

Cmd + S Save the active document

Cmd + Shift + S Save the active document under a new file name
Cmd + P Print Preview

Cmd + W Close active document

Cmd + Right Indent task

Cmd + Left Outdent task

Cmd + Down Move item to the next position (one line down)
Cmd + Up Move item to the previous position (one line up)
Cmd + L Link selected tasks

Cmd + Shift + L

Unlink selected tasks

Cmd +Opt+ G

Gantt Chart View

Cmd + Opt+R

Resource List View

Cmd + Opt + ] Projects Dashboard

Cmd + Opt + U Move to Resource Usage View

Cmd + R Call Reports dialog

Cmd +1 Projects Inspector

Cmd +2 Tasks Inspector

Cmd +3 Resource Assignments Inspector
Cmd +4 Resources Inspector

Cmd +5 Hyperlinks Inspector

Cmd +6 Notes Inspector

Cmd + Z Undo the last operation

Cmd + X Cut the selection to the Document
Cmd + C Copy the selection to the Document
Cmd + V Paste the content from the Document
Cmd + A Select all the tasks on document
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CS Odessa
Technical Support/Sales Phone Numbers

US/Canada/Mexico:

Technical Support (Toll Free): +1 (877) 441-1150 x4
amersupport@csodessa.com

Sales (Toll Free): +1 (877) 441-1150 x3
amersales@csodessa.com

Europe:
Technical Support: +38 (048) 760-1963
+44 (203) 514-7040

support@conceptdraw.com

Sales: +38 (048) 760-1963
sales@conceptdraw.com

© 2018, CS Odessa corp.
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